
Статический
 конструкционный анализ
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№ 4
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Статический
 

анализ

•
 

Цель
 

линейного статического конструкционного анализа –
 найти  отклик конструкции на статическую нагрузку. 

–
 

Вычисляемыми параметрами являются смещения, силы 
реакции, напряжения и деформации. 

•
 

Общее уравнение движения: 

где
 

[M] –
 

матрица масс, [C] –
 

матрица демпфирования, 
[K] –

 
матрица жесткости, {x} -

 
перемещение, {F} –

 
сила. 

•
 

Для статического анализа в уравнении движения все 
зависящие от времени слагаемые равны нулю: 

[ ]{ } [ ]{ } [ ]{ } ( ){ }tFxKxCxM =++ &&&

[ ]{ } { }FxK =
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Линейный
 

статический анализ
•

 
В линейном статическом конструкционном анализе 
решается матричное уравнение относительно 
перемещений {x}: 

Допущения линейного статического анализа. 
–

 
[K] (жесткость) является константой. 

•

 

Применяется линейная упругая модель поведения материалов. 
•

 

Используется теория малых перемещений. 
•

 

Могут быть включены в расчет некоторые нелинейные граничные 
условия. 

–
 

{F} (приложенная сила) является статической нагрузкой. 
•

 

Не рассматриваются силы, изменяющиеся во времени. 
•

 

Не рассматриваются явления инерции (масса, демпфирование). 

[ ]{ } { }FxK =



2009
http://cae.ustu.ru

© О. М. Огородникова

КО
М
П
Ь
Ю
ТЕРН

Ы
Й
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
КО

М
П
Ь
Ю
ТЕРН

Ы
Й

КО
М
П
Ь
Ю
ТЕРН

Ы
Й

КО
М
П
Ь
Ю
ТЕРН

Ы
Й
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
CAEngineering

4

Геометрическая
 

модель
•

 
В линейном статическом 
конструкционном анализе 
рассчитываются геометрические 
модели любой пространственной 
размерности.

•
 

Для поверхностных тел задается 
толщина

 
(thickness) в окне 

настроек раздела “Geometry”.

•
 

Сечение и направление линейных 
тел задается в модуле DesignModeler

 и транслируется в расчетный 
модуль автоматически.
–

 
Для линейных тел рассчитываются 
только перемещения.



2009
http://cae.ustu.ru

© О. М. Огородникова

КО
М
П
Ь
Ю
ТЕРН

Ы
Й
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
КО

М
П
Ь
Ю
ТЕРН

Ы
Й

КО
М
П
Ь
Ю
ТЕРН

Ы
Й

КО
М
П
Ь
Ю
ТЕРН

Ы
Й
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
CAEngineering

5

Точечная
 

масса
•

 
Точечную

 
массу (Point Mass) можно ввести в раздел Geometry 

дерева проекта, чтобы учесть в расчетах массу не 3-хмерной 
модели. 
–

 
Точечная масса вводится только 
для поверхностей. 

–
 

Положение точечной массы задается
•

 

координатами (x, y, z) в любой 
заданной системе координат

•

 

или выбором точки/ребра/поверхности. 
–

 
Величина точечной массы задается 
в позиции “Magnitude”

 
(значение) 

окна настроек.
–

 
В конструкционном статическом 
анализе точечная масса нагружается ускорением (Acceleration),

 вектором гравитации (Standard Earth Gravity) или скоростью 
вращения (Rotational Velocity).  Это  инерционные нагрузки. Другие 
нагрузки не доступны.

–
 

Точечная масса связана с выбранной поверхностью без явлений 
жесткости. Такое допущение означает не наличие области жестких 
связей, а равномерное распределение массы по поверхности.

–
 

Отсутствуют инерционные составляющие вращения. 
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Точечная
 

масса в статике
•

 
Точечная

 
масса обозначается графически на геометрической 

модели как сфера серого цвета. 
–

 
К точечной массе прикладываются только инерционные 
нагрузки.

–
 

Единственный случай, когда в линейном статическом анализе 
необходимо задавать точечную массу, -

 
введение в расчет 

дополнительного веса. 
–

 
Расчетные результаты 
собственно для точечной 
массы не анализируются. 
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Свойства
 

материала
•

 
Для

 
линейных статических расчетов необходимо указать 

модуль Юнга (Young’s Modulus) и коэффициент Пуассона 
(Poisson’s Ratio). 
–

 
Выбор материала осуществляется для детали в разделе 
“Geometry”

 
дерева проекта, изменение свойств производится 

в разделе “Engineering Data”.
–

 
Если прикладываются инерционные нагрузки, необходимо 
также задать плотность (Mass density). 

–
 

Если прикладываются тепловые нагрузки, необходимо задать 
температурный коэффициент линейного расширения (Thermal 
expansion coefficient) и теплопроводность (thermal 
conductivity). 

•

 

Тепловые нагрузки не доступны в модуле ANSYS Structural.
•

 

Возможен ввод отрицательного ТКЛР, что означает сжатие 
материала при нагреве.

–
 

Если анализируется запас прочности, необходимо указать 
предельные напряжения (пределы текучести, прочности). 

–
 

Если рассчитывается ресурс, необходимо ввести 
усталостные характеристики (Fatigue properties).
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Редактирование и ввод свойств
•

 
Свойства

 
редактируются во вкладке Engineering Data
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Сборка
 

–
 

контакт твердых тел
•

 
При

 
импортировании и чтении сборок препроцессором 

автоматически создаются контакты между деталями.
–

 
Контакт поверхность-поверхность (Surface-to-surface)

 
разрешает 

неэквивалентные сетки 
на поверхностях 
контактирующих тел. 

–
 

Расстояние 
автоматического 
поиска 
контакта задается 
параметром 
Tolerance

 
(допуск) 

в окне 
настроек раздела 
“Contact”, значение 
устанавливается 
бегунком. 
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Контактные
 

поверхности
•

 
В каждой области контакта выделяется контактная 
поверхность (contact) и целевая поверхность (target).
–

 
Контактная поверхность составлена из элементов типа “contact”, 
целевая –

 
из элементов типа “target”.

–
 

Существует ограничение на проникновение контактной 
поверхности в целевую: точки интегрирования на контактных 
поверхностях определяются глубиной проникновения контактной 
поверхности в целевую согласно заданному допуску.

•

 

Если в контактной области одна поверхность 
проявляет свойства контактной (жесткая), 
а другая –

 

целевой (пластичная), то контакт 
называют асимметричным. 
Если каждая поверхность является 
и контактной и целевой одновременно 
(одинаковая жесткость), контакт называют 
симметричным. В симметричном 
контакте нет взаимного 
проникновения поверхностей.

•

 

По умолчанию для сборок задается 
симметричный контакт.
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Контакт объемных тел
•

 
В

 
Simulation

 
поддерживается 4 типа контактов: 

–

 

Контакты типа Bonded
 

(связанный) и No Separation
 

(без разделения) 
являются линейными и рассчитываются за один проход. 

–

 

Контакты типа Frictionless
 

(без трения) и Rough
 

(жесткий) являются 
нелинейными и требуют при расчете множества итераций. 
Все контакты в статическом анализе 
рассчитываются, исходя 
из допущения малых перемещений.

•

 

Задавая нелинейный контакт, 
можно изменять настройки 
взаимодействия в позиции 
“Interface treatment”. 

•

 

“Add Offset”

 

(согласно геометрии 
и заданному смещению): введите 
значение, можно нулевое. 

•

 

“Adjusted to Touch”

 

(настраивать по касанию). 
Данная опция позволяет закрыть зазор 
при касании. Такие настройки для 
нелинейных контактов доступны в 
версиях  ANSYS Professional

 

и выше.

Contact Type Iterations Normal Behavior (Separation) Tangential Behavior (Sliding)
Bonded 1 Closed Closed
No Separation 1 Closed Open
Frictionless Multiple Open Open
Rough Multiple Open Closed
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Модели
 

контакта
•

 
Подробная

 
настройка контактных 

параметров доступна в окне 
настроек. 
–

 
Возможен выбор модели контакта: Pure 
Penalty

 
(метод штрафов),

 
Augmented 

Lagrange
 

(расширенный Лагранжа),
 

MPC,
 Normal Lagrange

 
(нормальный Лагранжа).

•

 

Метод Augmented Lagrange наиболее 
часто используется в

 

ANSYS.
•

 

Метод
 

Pure Penalty задает высокую 
жесткость контакта, что может привести к 
отрицательному относительному 
движению деталей в зоне контакта.

•

 

Метод MPC
 

используется только для 
связанных контактов.

•

 

В методе MPC
 

добавляются уравнения, 
ограничивающие движение деталей и 
исключающие их взаимное перемещение в 
зоне контакта. Данный метод может быть 
альтернативой методу штрафов для 
связанных контактов. 
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Область
 

захвата
•

 
Подробные

 
настройки контакта.

–
 

Можно добавить и визуально 
просмотреть область захвата (pinball 
region).

•

 

Область захвата задает зону ближнего 
открытого контакта (near-field contact). За 
пределами этой области находится

 

зона 
дальнего открытого контакта (far-field 
contact).

•

 

Область захвата участвует в 
эффективном поиске контакта, но может 
быть использована и для других целей, 
например, при определении связанного 
контакта. 

•

 

Для связанного контакта
 

(bonded) или 
контакта без разделения

 

(no separation) 
зазор меньше области захвата

 

(pinball 
region) автоматически закрывается, 
взаимное проникновение поверхностей, 
изначально находившихся на 
расстоянии меньше области захвата, 
игнорируется.

Зазор

 

больше области захвата 
автоматически не закрывается.
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Сборка
 

–
 

контакт оболочек
•

 
В

 
версиях

 
ANSYS Professional

 
и выше поддерживаются 

геометрические модели, составленные из оболочек и 
твердых тел. 
–

 
Смешанная сборка позволяет использовать расчетные 
преимущества оболочек. 

–
 

Доступно большее количество контактных опций. 
–

 
Возможен постпроцессинг

 
контактов.
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Контакт
 

по ребрам
•

 
Можно

 
задавать контакт по 

ребрам.
–

 
Для контактов оболочек или 
твердых тел по ребрам можно 
задавать только связанный 
(bonded) тип или без разделения 
(no separation).

–
 

Для контакта оболочек по ребрам 
задается только связанный тип 
(bonded) и метод MPC.

•

 

В методе MPC
 

для связанного 
контакта задается направление 
поиска контакта по нормали к 
целевой поверхности или область 
захвата.

•

 

Если существует зазор (как 
правило, зазор существует в 
оболочковых сборках), можно 
ввести область захвата для 
определения контакта.
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Сборка
 

–
 

обзор контактов
•

 
Возможны

 
следующие типы контактов: 

Геометрия контакта Solid Body Face Solid Body Edge Surface Body Face Surface Body Edge
Все типы Bonded, No Separation Bonded, No Separation Bonded only
Все формулировки Все формулировки Все формулировки MPC formulation
Symmetry respected Asymmetric only Symmetry respected Asymmetric only

Bonded, No Separation Bonded, No Separation Bonded only
Все формулировки Все формулировки MPC formulation
Asymmetric only Asymmetric only Asymmetric only

Bonded, No Separation Bonded only
Все формулировки MPC formulation
Symmetry respected Asymmetric only

Bonded only
MPC formulation
Asymmetric only

Solid Body Face

Solid Body Edge

Surface Body Face

Surface Body Edge
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Сборка
 

–
 

точечная сварка
•

 
Точечная

 
сварка (Spot welds) обеспечивает соединение 

оболочковых деталей
 

в сборке и задается в дискретных 
точках. 
–

 
В модуле Simulation

 
не поддерживаются контакты оболочек, и 

точечная сварка является единственным способом задать 
оболочковую сборку.

–
 

Точечная сварка задается в CAD программе. Модуль 
DesignModeler

 
определяет точечную сварку таким образом, 

что она понимается при 
трансляции геометрической 
модели на расчет.

–
 

Точечную сварку можно 
задать в препроцессоре 
вручную, привязав 
ее дискретно к точкам. 
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Нагрузки
 

и закрепление
•

 
В

 
конструкционном анализе существует 4 типа нагрузок. 

–
 

Inertial loads
 

–
 

инерционные нагрузки.
•

 

Действуют на всю конструкцию. 
•

 

Необходимо задавать плотность материала для вычисления массы. 
•

 

Можно задавать нагрузку, действующую только на точечную массу. 
–

 
Structural Loads

 
–

 
конструкционные нагрузки.

•

 

Это силы и моменты, действующие на детали конструкции. 
–

 
Structural Supports

 
–

 
закрепление.

•

 

Это ограничение степеней свободы, которое исключает движение 
заданных объектов. 

–
 

Thermal Loads
 

–
 

тепловые нагрузки.
•

 

Это тепловые нагрузки, которые приводят к неоднородному 
распределению температуры и тепловому расширению конструкции.
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Анализ
 

переходных процессов
•

 
В

 
текущей версии доступен динамический анализ 

переходных процессов.

•
 

По умолчанию устанавливается статическое нагружение.

•
 

Можно перейти к опциям переходного - “transient” или 
гармонического - “harmonic” анализа. 

•
 

При определении задачи  можно задать последовательность 
статических нагружений

 
в виде условных временных шагов.

•
 

Все шаги нагружения
 

будут решены после запуска задачи на 
расчет. Расчетные результаты для каждого шага нагружения

 просматриваются последовательно в постпроцессинге.
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Временные
 

шаги
•

 
В

 
позиции “Steps” главного меню задайте нужное количество 

последовательных временных шагов.

•
 

Введите величину нагрузки для каждого временного шага в 
графическом окне.

•
 

Диаграмма в графическом окне показывает изменение 
нагрузки во времени, а легенда в графическом окне 
показывает настройки для текущего шага.
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Постпроцессинг
 

шагов
•

 

Результаты
 

расчета можно просмотреть последовательно, выбирая 
на диаграмме необходимый шаг нагружения

 

или выбором “Правая 
клавиша мыши

 

> Retrieve Results”.
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Направление
 

нагрузки
•

 
Для

 
большинства ориентированных в 

пространстве нагрузок и перемещений, 
направление можно задать 
компонентами в любой декартовой 
системе координат. 
–

 
Для этого сначала нужно задать или 
выбрать систему координат. 

–
 

В окне настроек в позиции “Define By” 
выберите опцию

 
“Components”.  Затем 

в списке дерева проекта выберите 
нужную систему координат.

–
 

Задайте величины компонент нагрузки 
в направлениях x, y, z относительно 
выбранной системы координат. 

Load Supports Coordinate Systems
Acceleration No
Standard Earth Gravity No
Rotational Velocity No
Force Yes
Remote Force Location of Origin Only
Bearing Load Yes
Moment Yes
Given Displacement Yes

В виде компонент можно 
задать только нагрузки, 
перечисленные в таблице

 
с пометкой YES.
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Ускорение
 

и гравитация
•

 
Acceleration -

 
ускорение –

 
инерционная нагрузка. 

–
 

Ускорение прикладывается ко всей конструкции.
–

 
Следует обратить внимание на направление. Если ускорение 
прикладывается к конструкции одномоментно, инерционные 
силы сопротивляются приложенной нагрузке и действуют в 
противоположном направлении. 

–
 

Ускорение может быть задано вектором или его 
компонентами. 

•
 

Standard Earth Gravitation –
 

обычная гравитация –
 инерционная нагрузка. 

–
 

В единицах измерения СИ величина гравитационного 
ускорения равна 9.80665 м/с2

–
 

Направление гравитации задается вдоль одной из осей 
глобальной системы координат.
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Скорость
 

вращения
•

 
Rotational velocity –

 
скорость вращения –

 
инерционная 

нагрузка. 
–

 
Вращение всей конструкции относительно оси с заданной 
скоростью. 

–
 

Может быть определена как вектор, тогда с использованием 
геометрической модели задается ось вращения и 
записывается величина. 

–
 

Может быть определена компонентами вектора в глобальной 
или локальной системе координат. 

–
 

Важно точно задать ось вращения.
–

 
По умолчанию единицы измерения –

 
радианы в секунду. 

Определение по умолчанию можно изменить в меню: “Tools
 

> 
Control Panel

 
> Miscellaneous > Angular Velocity”, альтернатива 

–
 

радианы в минуту (RPM).
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Силы
 

и давление
•

 
Pressure -

 
давление:

–
 

Давление прикладывается к поверхности и в каждой точке 
действует по нормали. 

–
 

Положительное значение задает давление на поверхность, 
отрицательное –

 
от поверхности.

–
 

Единицы измерения –
 

сила, поделенная на площадь. 

•
 

Force -
 

сила:
–

 
Силу можно приложить в точке, а также распределить по ребру 
или по поверхности.

–
 

Приложенная сила распределяется на все 
выделенные объекты. Например, если сила 
приложена к двум одинаковым поверхностям, 
на каждую действует половина заданной величины. 
Единицы измерения –

 
масса*длина/время2

–
 

Сила задается направлением вектора и величиной 
или компонентами вектора в назначенной системе 
координат.
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Давление
 

опоры
•

 
Bearing Load –

 
давление опоры.

–

 

Давление опоры задается только для цилиндрической поверхности.
 Радиальная компонента распределена по указанной поверхности 

неравномерно и максимальна со стороны сжатия, как показано на 
примере.

–

 

Осевая компонента распределена только по цилиндру и равномерно.
–

 

Для цилиндрической поверхности задается только одна нагрузка 
давления опоры. Если цилиндрическая поверхность 
является составной, следует 
выбрать все составляющие 
части поверхности.

–

 

Единицы измерения –
 

сила (Н). 
–

 

Может быть задана вектором 
или компонентами вектора 
в любой системе координат. 
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Момент
•

 
Moment –

 
момент.

–
 

Для твердых тел момент силы задается на 
любой поверхности. 

–
 

Если выбрано несколько поверхностей, 
момент делится на все выбранные 
поверхности. 

–
 

Задается направлением и величиной вектора или 
компонентами вектора в выделенной системе координат. 
Момент действует относительно указанного вектора и 
направлен по правилу правой руки. 

–
 

Для поверхностных тел момент прикладывается в точке или 
к ребру и задается вектором или компонентами вектора. 

–
 

Единицы измерения –
 

сила*длина 
(Н*м).
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Удаленная
 

нагрузка
•

 
Remote Load

 
–

 
удаленная нагрузка.

–
 

Позволяет приложить к поверхности или ребру 
поверхностного тела силу, реальная точка приложения 
которой находится за пределами выбранного 
геометрического объекта. 

–
 

Необходимо указать точку приложения силы (вершину, 
цилиндр…) или задать координаты x, y, z. Можно 
использовать произвольно заданную систему координат.

–
 

Сила задается направлением вектора и его величиной или 
компонентами вектора в глобальной системе координат.

–
 

Удаленная нагрузка эквивалентна действию силы на 
поверхность или моменту силы, 
величина которого определяется 
положением точки приложения. 

–
 

Приложенная сила 
распределена по поверхности. 

–
 

Единицы измерения –
 

сила (Н).

Поверхность, к которой 
приложена удаленная 
сила.
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Болтовое
 

натяжение
•

 

Bolt Load
 

–
 

болтовое натяжение.
–

 

Прикладывает предварительную нагрузку к цилиндрической поверхности, 
моделируя затянутый болт.

–

 

Задается как усилие натяжения (сила) или установочный размер (длина) в 
начальных условиях.

–

 

Может задаваться как дополнительная опция в последовательных нагрузках.
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Болтовое
 

натяжение
•

 
В

 
статическом анализе предварительная нагрузка 

прикладывается в начальном решении, а внешние нагрузки 
прикладываются в последующих решениях.

–

 

Эти шаги решения –
 

предварительное нагружение
 

и внешнее 
нагружение

 

–
 

выполняются последовательно.
•

 
Болтовое натяжение автоматически блокируется при 
последующих шагах решения.

•
 

В пошаговом нагружении
 

пользователь может блокировать 
или разрешить болтовое натяжение на всех шагах нагружения

 за исключением первого шага.



2009
http://cae.ustu.ru

© О. М. Огородникова

КО
М
П
Ь
Ю
ТЕРН

Ы
Й
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
КО

М
П
Ь
Ю
ТЕРН

Ы
Й

КО
М
П
Ь
Ю
ТЕРН

Ы
Й

КО
М
П
Ь
Ю
ТЕРН

Ы
Й
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
CAEngineering

31

Болтовое
 

натяжение
•

 
Болтовые

 
нагрузки:

–

 

Можно использовать только в трехмерных моделях.
–

 

Можно приложить к цилиндрическим поверхностям и телам. Для тел 
следует выбрать локальную систему координат с осью Z, 
направленной вдоль предварительного натяжения.

–

 

Рекомендуется уплотнить сетку так, чтобы по сечению болта 
укладывалось 2 или более элементов.
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Ограничение
 

смещений
•

 
Fixed Support

 
–

 
жесткая заделка.

–
 

Ограничивает все степени свободы выбранных вершин, ребер, 
поверхностей. 

–
 

Для твердых тел исключает перемещение в направлениях x,y,z
–

 
Для поверхностных и линейных тел исключает перемещение в 
направлениях x,y,z

 
и поворот относительно x, y, z

•
 

Given Displacement
 

–
 

заданное перемещение. 
–

 
Задает перемещение выбранных вершин, ребер, поверхностей. 

–
 

Заданное перемещение осуществляется в направлениях x, y, z 
пользовательской системы координат.

–
 

Значение “0” для компоненты перемещения означает 
закрепление выбранного объекта в данном направлении.

–
 

Незаданное значение компоненты означает свободное 
движение выбранного объекта в данном направлении. 
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Закрепление
 

твердых тел
•

 
Frictionless Support

 
–

 
закрепление без трения.

–
 

Запрещает перемещение по нормали к поверхности. 
–

 
Для твердых тел закрепление без трения может задавать 
граничные условия типа плоскости симметрии (плоскость 
симметрии задается запрещением перемещений по нормали). 

•
 

Cylindrical Constraint
 

–
 

цилиндрическое закрепление.
–

 
Применяется к цилиндрической поверхности. 

–
 

Закрепление возможно в осевом, радиальном или 
касательном направлениях.  

–
 

Применяется только при малых деформациях в линейном 
анализе. 
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Закрепление
 

твердых тел
•

 
Compression Only Support

 
–

 
закрепление сжатия.

–
 

Применяется к поверхности, запрещает движение по нормали 
в направлении сжатия.

–
 

Моделирует жесткое закрепление поверхности 
контактирующей деталью в сборке, имеющей такую же 
форму. Такое закрепление позволяет не вводить 
контактирующую деталь в расчет явно.

–
 

Можно использовать для закрепления 
цилиндрической поверхности, где форма 
сжимаемой стороны остается неизменной. 
Сторона, работающая на растяжение, 
подвергается деформации.

–
 

Требует итерационного нелинейного решения.
•

 

Сжимаемая сторона не известна заранее, поэтому 
необходим итерационный решатель, чтобы выявить, какая 
сторона работает на сжатие.
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Закрепление
 

линейных и поверхностных тел

•
 

Simply Supported –
 

запрет перемещений.
–

 
Применяется к ребрам или вершинам поверхностных или 
линейных моделей. 

–
 

Запрещает перемещение вдоль осей, но разрешает вращение. 

•
 

Fixed Rotation
 

–
 

запрет поворотов.
–

 
Применяется к поверхностям, ребрам или вершинам 
поверхностных или линейных моделей.

–
 

Запрещает поворот вокруг осей, но разрешает перемещение 
вдоль осей. 
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Тепловые
 

нагрузки
•

 
Изменение

 
температуры вызывает тепловое расширение 

конструкции. 
–

 

Тепловая деформация вычисляется по формуле:
 

где
 

α

 

–
 

температурный коэффициент линейного расширения (ТКЛР), Tref

 
–

 

исходная температура, относительно которой измеряется тепловое 
расширение, T

 

–
 

приложенная температура, εth

 

–
 

тепловая деформация. 
–

 

Тепловое расширение не вызывает 
напряжений само по себе. Тепловые 
напряжения возникают вследствие 
ограничения перемещений, 
температурных градиентов 
или различных ТКЛР деталей сборки.

–

 

ТКЛР (Thermal Expansion) задается вместе 
со свойствами во вкладке “Engineering

 

Data” 
и измеряется в 1/К. 

–

 

Исходная температура (Reference Temperature) 
задается в окне настроек раздела “Environment”.

( )ref
z
th

y
th

x
th TT −=== αεεε
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Тепловые
 

нагрузки
•

 
Тепловыми

 
нагрузками в конструкционном анализе 

являются температуры.
–

 
Различные температуры могут быть заданы для

 
разных 

частей и объектов геометрической модели.
–

 
В случае тепловых нагрузок сначала решается тепловая 
задача, затем рассчитанные температурные поля передаются 
на расчет напряженно-деформированных состояний.
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Опции
 

решателя
•

 
Опции

 
решателя устанавливаются в разделе “Solution” 

дерева проекта.
–

 
Расчетные результаты можно 
сохранить

 
в

 
формате ANSYS, выбрав Yes

 в
 

соответствующей позиции окна настроек. 
•

 

Применяется, если базу данных предполагается 
открывать в ANSYS.

–
 

Доступны два решателя. 
•

 

Решатель выбирается программой автоматически.
•

 

В процессе решения появляются информационные 
сообщения. Установки по умолчанию можно 
изменить в меню “Tools

 

> Options
 

… >
 Simulation: Solution

 

> Solver Type”.
•

 

Прямой решатель
 

(Direct
 

solver
 

= Sparse) 
используется

 

для моделей, содержащих 
поверхностные и линейные тела. 
Это устойчивый решатель,

 

который хорошо 
справляется с проблемными ситуациями.

•

 

Итерационный решатель
 

(Iterative
 

solver = PCG) более 
эффективен при расчете массивных твердотельных моделей.
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Опции
 

решателя
–

 
Для

 
устойчивости модели можно ввести слабые пружины 

(Weak springs). 
•

 

Если опции решателя выбираются программой 
(Program Controlled), программа старается 
стабилизировать недостаточно жестко 
закрепленные модели. Если в граничных 
условиях не задана жесткая заделка 
(Fixed Support), программа может добавить

 слабые пружины, о чем информирует 
в сообщениях. 

•

 

Можно разрешить“On” или запретить
 

“Off”
 введение слабых пружин. Установки 

по умолчанию можно изменить в меню 
“Tools

 

> Options
 

… > Simulation: 
Solution

 

> Use Weak Springs”.
•

 

В некоторых расчетных случаях, когда 
предполагается равновесное состояние 
конструкции, можно не ограничивать 
перемещения. В таких случаях введение 
слабых пружин предотвращает сингулярность 
матрицы жесткости.

•

 

В общем случае следует ограничивать 
перемещения. 
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Опции
 

решателя
–

 
В окне настроек присутствует информация о решателе.

•

 

Указан тип анализа. В данном случае – “Static Structural” – статический 
конструкционный.

•

 

Если при определении задачи заданы опции, 
требующие нелинейное решение, например, 
нелинейные контактные условия, тогда 
выбирается нелинейный тип решателя. 
В этом случае решение проходит через 
большое количество итераций и требует 
больше времени, чем в случае линейного 
решателя.

•

 

Временные файлы решатель записывает по 
умолчанию в папку TEMP системной папки 
Windows. Установку по умолчанию можно 
изменить в меню: “Tools > Options … > 
Simulation: Solution > Solver Working Directory”.  
Убедитесь, что достаточно 
пространства на указанном устройстве.

•

 

Все сообщения, появившиеся при решении, 
можно впоследствии прочитать в позиции 
“Solver Messages”

 

окна настроек.
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Расчет
•

 
Расчет

 
запускается пиктограммой “Solve” 

в стандартных инструментах. 
–

 
По умолчанию расчет ведется параллельно на двух 
процессорах. Количество участвующих в расчете процессоров 
можно изменить в меню “Tools

 
> Options

 
… > Simulation: 

Solution
 

> Number of Processors to Use”.
–

 
Если в дерево 
проекта включен 
раздел “Solution 
Information”, 
можно 
контролировать 
процесс 
вычислений.
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Расчетные
 

результаты
•

 
В

 
постпроцессоре возможен просмотр следующих расчетных 

результатов. 
–

 

Направленная и общая деформация. 
–

 

Компоненты тензоров напряжений и деформаций, главные 
нормальные значения и инварианты. 

–

 

Контакты в версии ANSYS Professional и выше.
–

 

Силы реакции опор. 

•
 

В Simulation
 

расчетные параметры указываются и включаются в 
дерево проекта до начала вычислений, но могут быть запрошены 
и позднее.

–

 

Чтобы запросить расчетный параметр после вычислений, следует его
 добавить в дерево проекта и нажать пиктограмму “Solve” . 

–

 

Вычисления не проводятся заново в линейном анализе, расчетные 
данные только обновляются постпроцессором для визуализации. 
Пример: в дереве проекта уже присутствует общая деформация -

 

total 
deformation, а запрашивается деформация вдоль некоторого 
направления -

 

direction deformation.
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Просмотр
 

расчетных результатов
•

 
Расчетные

 
результаты обычно представляются на 

деформированной конструкции в виде изопараметрических
 контуров или векторов. С помощью контекстных инструментов 

можно изменить масштаб визуализации деформаций, шкалу или 
способ представления.
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Перемещения
•

 
Смещения

 
в конструкции можно просмотреть в 

постпроцессинге. ЖЖЖ
–

 
Total deformation –

 
полное смещение –

 
является 

скалярной величиной:

–
 

Компоненты смещения в направлениях x, y, z 
можно вызвать в позиции “Directional”

 
–

 
направленное 

смещение. В окне настроек можно выбрать систему 
координат -

 
“Coordinate System”.

•

 

Например, просто интерпретировать смещение цилиндрической 
поверхности в радиальном направлении, используя 
цилиндрическую систему координат.

–
 

Чтобы просмотреть смещение в  векторном представлении, 
следует выбрать каркасное 
представление модели -

 
wireframe.

222
zyxtotal UUUU ++=
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… Смещение

•
 

Смещение
 

вычисляется для всех типов тел –
 

линейных, 
поверхностных и твердых.  
–

 
Смещение представляется только перемещением вдоль осей. 
Сдвиг, обусловленный поворотом относительно осей 
координат, не выводится. 

–
 

Сходимость контролируется с помощью соответствующего 
инструмента -

 
Convergence.

–
 

Инструменты предупреждения -
 

Alert или сходимости -
 Convergence используются в представлении скалярных 

величин -
 

полной
 

“Total” или направленных
 

“Directional” 
смещений.

 
Эти инструменты не используются при векторном 

представлении смещений.
–

 
Полное смещение -

 
“Total” является инвариантой, для 

представления этого параметра не указывается система 
координат. Векторное представление смещений проводится в 
глобальной системе координат. 
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… Напряжение  и деформация

•
 

Stresses –
 

напряжения 
и

 
strains –

 
деформация. 

–

 

Вычисляется упругая деформация -
 elastic

 

strains
–

 

Напряжения и деформация 
являются тензорными величинами 
и имеют 6 компонентов (x, y, z, xy, yz, xz), 
тепловые напряжения представляются 
вектором и имеют 3 компоненты (x, y, z).

–

 

Для напряжений и деформаций могут быть вызваны 
компоненты нормальные -

 

“Normal” (x, y, z) и сдвиговые - “Shear” 
(xy, yz, xz).  Тепловые деформации (x, y, z) вызываются в позиции 
“Thermal.”

•

 

Представление зависит от выбора системы координат. 
•

 

Тепловые напряжения не вычисляются в модуле ANSYS Structural.
•

 

Вычисляются только для твердых и поверхностных тел. Для линейных

 
тел вычисляется только перемещение. 
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… Напряжение  и деформация
•

 
Для

 
оценки конструкции вычисляется запас 

прочности -
 

Safety Factors.
–

 
Поскольку напряжение является тензором, 
сложно оценить отклик системы на нагружение, анализируя 
собственно тензор напряжений. 

–
 

Раздел
 

“Stress Tool” дерева проекта 
позволяет вычислить скалярные 
величины и соотнести их с критерием 
надежности. 

–
 

Напряжения можно вычислять 
в предположении различных 
моделей материала.

–
 

В разделе
 

“Stress Tool” выбираются 
теория прочности и предельные 
величины.
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… Главные нормальные напряжения

•
 

Principal Stresses and Strains
 

–
 

главные 
нормальные напряжения и деформации.
–

 
Тензор напряжений в точке можно повернуть таким 
образом, что все сдвиговые компоненты окажутся 
равными нулю. Оставшиеся на диагонали 
нормальные напряжения называются главными -

 
principal 

stresses, для них справедливо соотношение:
 

σ1

 

< σ2

 

< σ3

 

.
–

 
Тройка главных нормальных напряжений определяет вектор 
в точке -

 
“Vector Principal”.

–
 

На примере представлены главные 
напряжения (белый=max, синий=min).  
Деталь изгибается таким образом, что 
с одной стороны происходит растяжение,

 с другой –
 

сжатие.
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… Главные нормальные напряжения

•
 

Критерий
 

прочности –
 

максимальное растягивающее напряжение -
 Maximum Tensile Stress Theory.

–

 

Критерий прочности используется для хрупких материалов. 
Используемый расчетный параметр –

 

первое (максимальное) главное 
нормальное напряжение.

–

 

Критерий сравнивает расчетный параметр σ1

 

с пределом прочности 
материала или назначенным предельным растягивающим 
напряжением σt

 

. 
–

 

В пространстве главных напряжений область разрушения ограничена 
квадратом. Все случаи напряженных состояний внутри квадрата 
обеспечивают надежную работу конструкции. Вне квадрата и на его 
границах внутренние 
напряжения разрушают материал конструкции.

–

 

Для хрупких материалов разрушение сжатием 
требует напряжений в несколько раз больше, чем 
при растяжении. Поэтому при анализе прочности 
хрупких материалов выбираются максимальные 
растягивающие напряжения.

σ1

σ2

σt

σt

1σ
σ t

safetyF =
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… Главные нормальные напряжения

•
 

Критерий
 

прочности Мора-Кулона -
 

Mohr-Coulomb Theory.
–

 
Используется для хрупких материалов. Используемые 
расчетные параметры –

 
максимальное и минимальное (первое 

и третье) главные нормальные напряжения.
–

 
Критерий сравнивает расчетные параметры 
с пределом прочности на растяжение σt

 
и пределом прочности на сжатие

 
σc

–
 

Область разрушения в пространстве 
главных напряжений учитывает зоны 
сжатия и приведена на рисунке.

1

31

−

⎥
⎦

⎤
⎢
⎣

⎡
+=

ct
safetyF

σ
σ

σ
σ

σ1

σ2

σt

σt

−σc

−σc
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… Эквивалентные напряжения
•

 
Equivalent Stress

 
–

 
эквивалентные напряжения.

–
 

Эквивалентные напряжения или напряжения Мизеса
 

σe

 
определяются следующим образом:

–
 

Критерий используется для пластичных материалов.
–

 
Результаты стандартных одноосных испытаний на 
растяжение с целью определения предела текучести и 
предела прочности материала (а также выявления модели 
материала по кривой упрочнения) соотносятся с тензором 
напряжений через инварианту –

 
эквивалентные напряжения.

( ) ( ) ( )[ ]2
13

2
32

2
212

1 σσσσσσσ −+−+−=e
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… Эквивалентные напряжения

•
 

Критерий
 

прочности –
 

максимальные эквивалентные напряжения 
–

 
Maximum Equivalent Stress Theory.

–

 

Используется для пластичных материалов. Используемый расчетный 
параметр –

 

эквивалентные напряжения.
–

 

Критерий сравнивает эквивалентные 
напряжения σy

 

с пределом текучести. 
–

 

Область разрушения в пространстве главных 
напряжений ограничена эллипсом.

–

 

Напряженное состояние можно разделить на две составляющие –
 гидростатическую и искажающую. (Соответствующие деформации –

 растяжение/сжатие и сдвиг. Соответствующие 
смещения –

 

трансляция вдоль осей и поворот.) 
Гидростатическая составляющая вызывает 
изменение объема и разрушает отрывом; это 
хрупкое разрушение. Искажающая составляющая 
изменяет форму и разрушает сдвигом; это 
пластичное разрушение. Критерий называют 
также критерием энергии искажения -

 distortion energy criterion.

e

y
safetyF

σ
σ

=

σ1

σ2

σy

−σy

−σy

σy
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… Максимальное напряжение сдвига

•
 

Maximum Shear Stress
 

–
 

максимальное 
сдвиговое напряжение.
–

 
Максимальное сдвиговое напряжение τmax

 

определяется как 
полуразность

 
главных нормальных напряжений:

 

и является наибольшим из главных сдвиговых напряжений. 
–

 
Используется для пластичных материалов, сравнивается с 
пределом текучести, является критерием пластического 
течения. 

•
 

Stress Intensity
 

–
 

интенсивность напряжений.
–

 
Значение интенсивности напряжений вдвое больше 
максимального сдвигового напряжения.

–
 

Определяется как разность максимального и минимального 
главных нормальных напряжений. 

2
31

max
σστ −

=
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… Максимальное напряжение сдвига

•
 

Критерий
 

максимального напряжения сдвига -
 

Maximum Shear 
Stress Theory.
–

 
Критерий (Tresca

 
criterion) используется для пластичных 

материалов.
–

 
Критерий сравнивает максимальное напряжение 
сдвига с пределом текучести σy

 

Коэффициент 
пропорциональности f

 
по умолчанию равен

 
0.5

–
 

Область разрушения по критерию Треска в пространстве 
главных напряжений сопоставима с эквивалентными 
напряжениями (на рисунке показаны желтой 
и пунктирной линиями). Различие в оценке 
двумя методами не превышает 15%, но 
критерий Треска более консервативен. 

maxτ
σ y

safety

f
F =

σ1

σ2

σy

−σy

−σy

σy
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… Контактные результаты

•
 

Расчетные
 

результаты в области контакта.
–

 

Контактные результаты можно просмотреть 
для твердых и поверхностных тел, имеющих 
контактные элементы.

–

 

Для определения контакта в
 

ANSYS используется 
концепция контактных -

 

contact и целевых - target 
поверхностей.  Контактные результаты выводятся только 
для контактных поверхностей. Контактные результаты не выводятся 
для контактов  MPC, для целевых поверхностей, для контакта ребер. 
Контакт линейных тел в DS не поддерживается.

•

 

При асимметричном контакте результаты выводятся только для 
контактной поверхности, для целевой поверхности выводятся нулевые 
значения.

•

 

При симметричном контакте результаты выводятся для обеих 
поверхностей.  Для контактного давления выводится среднее значение по 
двум контактным поверхностям.

–

 

Контактные результаты запрашиваются через позицию “Contact 
Tool” раздела

 

Solution.
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… Контактные результаты

•
 

Контактные
 

результаты можно выбрать в списке при 
выделенном разделе “Contact Tool”

 
дерева проекта.

–
 

В табличной вкладке графического окна можно выбрать 
контактную область, для которой следует просмотреть 
контактные результаты.

–
 

Контактные результаты можно выбрать с помощью 
контекстных инструментов. 

Можно

 

включить в дерево 
проекта несколько позиций 
“Contact Tool”, чтобы 
просмотреть контактные 
области раздельно. 
Используйте правую клавишу 
мыши для выбора и связывания 
контактных областей с 
контактными результатами.
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… Контактные результаты

•
 

Можно
 

просмотреть следующие контактные результаты. 
–

 

Contact Pressure
 

–
 

контактное давление –
 распределение нормального контактного давления. 

–

 

Contact Penetration
 

–
 

перекрытие поверхностей 
в области контакта.

–

 

Gap
 

–
 

зазор между контактными поверхностями 
в пределах области захвата.

–

 

Sliding Distance
 

–
 

относительное смещение в зоне контакта.
–

 

Frictional Stress
 

–
 

касательная контактная сила трения.
–

 

Contact Status
 

–
 

состояние контакта –
 

закрытый 
(closed state), если контакт осуществился, 
или открытый

 

(open state), если 
поверхности не касаются.

•

 

Для открытого состояния ближний контакт 
(near-field) означает, что расстояние меньше 
области захвата, дальний контакт (far-field) 
означает, что расстояние больше области 
захвата. 

Результаты

 

представляются контурами 
на контактных поверхностях внутри 
полупрозрачной модели. 
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… Контактные силы

•
 

Если
 

выбрана позиция
 

“Reactions” в списке контактных 
результатов, выводится информация о силах и моментах 
в области контакта. 
–

 
В табличной вкладке Worksheet выводится текстовая 
информация о контактных силах. 

–
 

Во вкладке
 

Geometry
 

графического окна показаны 
направления сил и моментов.
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… Сила реакции опоры

•
 

Для
 

каждого закрепления вычисляются силы реакции 
опоры и моменты.  
–

 
По окончании расчетов в окне настроек для 
каждого закрепления выводится информация 
о силах реакции и моментах. X, y, z компоненты 
указаны в глобальной системе координат. 
Момент указан относительно центра тяжести.

–
 

Силы реакции слабых пружин приводятся в 
окне настроек раздела “Environment”

 
после 

вычислений. Эти силы должны быть 
пренебрежимо малыми.
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… Сила реакции опоры

•
 

В табличной вкладке “Worksheet” раздела “Environment” 
выводится обзорная информация о силах реакции и 
моментах. 
–

 
Если к закрепленным объектам приложены нагрузки, заданы 
другие закрепления и контактные условия, сообщения о 
силах реакции могут быть неверными. Решение верно. 
Ошибка сообщения вызвана множественным нагружением

 
и 

закреплением узлов сетки. 



2009
http://cae.ustu.ru

© О. М. Огородникова

КО
М
П
Ь
Ю
ТЕРН

Ы
Й
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
КО

М
П
Ь
Ю
ТЕРН

Ы
Й

КО
М
П
Ь
Ю
ТЕРН

Ы
Й

КО
М
П
Ь
Ю
ТЕРН

Ы
Й
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
CAEngineering

61

… Усталость

•
 

Усталость
 

анализируется в отдельном модуле Fatigue Module.
–

 
Включение позиции “Fatigue Tool” в дерево проекта позволяет 
вычислять срок службы деталей. 

–
 

Возможно приложение постоянной или циклической нагрузки с 
симметричным или асимметричным циклом. 

Матрица

 

разрушений в критической области Контурное

 

представление запаса прочности
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… Просмотр результатов в ANSYS

•
 

Просмотр
 

расчетных результатов производится в главном 
постпроцессоре /POST1 по окончании вычислений и 
протоколируется во входном файле ANSYS.
–

 
Контурное представление расчетных результатов в DS

 аналогично узловому усредненному представлению в ANSYS. 
•

 

Просмотр контуров в ANSYS
 

задается командой PLNSOL при 
включенной опции полной графики

 

/GRAPH,FULL
•

 

Команды вывода расчетных результатов можно включить в файл 
ввода -

 

input file.
–

 
Силы реакции так же, как и узловые расчетные результаты 
передаются в DS

 
через файл XML

•

 

Используются команды XMLOPT и /XML
–

 
Контактные силы представляются для выбранной 
поверхности параметром FSUM относительно центра тяжести.



Линейный
 

конструкционный 
анализ

Лабораторная
 

работа № 4
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Тема: линейный конструкционный анализ

•
 

Цель.
 Сборка состоит из 5 деталей. К ремню приложена сила 100 Н. 

–
 

Убедиться, что упругие смещения на крыльчатке не превышают 
0.075

 
мм.

–
 

Убедиться, что напряжения в пластмассовом корпусе не 
превышают предельных значений для материала.
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Допущения

•
 

Корпус
 

насоса жестко закреплен в сборке. Такое допущение 
позволяет применить закрепление без трения к опорной 
поверхности корпуса.

•
 

Закрепление без трения также применяется для 
моделирования болтового соединения. Если необходимо 
более точно вычислить напряжения в зоне соединения, 
следует применить закрепление сжатия.

•
 

Нагрузка 100 Н прикладывается к шкиву как реакция опоры, 
таким образом моделируется передача нагрузки от ремня. 
Такой тип нагрузки позволяет распределить силу по 
поверхности контакта шкива и ремня аналогично 
закреплению сжатия.
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Контактные
 

условия
•

 
При

 
решении используется два типа линейных контактов –

 связанный и без разделения. Выбор контактных условий 
является важным этапом моделирования.
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Запуск
 

программы

•
 

В окне запуска выберите 
пиктограмму Simulation.

•
 

Импортируйте геометрическую 
модель:

 
выберите в дереве проекта 

позицию “Geometry > From File . . . “ 
выберите в рабочей папке файл 
“labrab3.x_t”.

•
 

В рабочем окне DS закройте мастер 
расчетов.
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Препроцессинг
1.

 
Укажите

 
метрическую систему единиц измерения (мм, МПа):

–
 

“Units > Metric (mm, Kg, MPa, C, s)”.

2.
 

Выберите в дереве проекта корпус насоса (part 1):
–

 
“Model > Geometry > Part 1”.

3.
 

В окне настроек для корпуса выберите в списке материалов 
пластмассу (polyethylene).

1

2 3
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. . . Препроцессинг
•

 
Назначьте

 
тип контакта для первых 

четырех областей контакта –
 

без 
разделения (No Separation).

4.
 

Удерживая клавишу shift, выделите 
первые 4 позиции в списке контактов.

5.
 

В окне настроек выберите в списке 
типов контакта –

 
без разделения (no 

separation).

•
 

Остальные контакты в списке 
останутся по умолчанию связанными 
(bonded).

4

5
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Нагружение
•

 
Приложите

 
давление опоры (bolt load):

6.
 

Выделите в дереве проекта раздел 
Environment.

7.
 

Выделите поверхность шкива.

8.
 

Включите в дерево проекта давление 
опоры

 
(bolt load):

–
 

“RMB > Insert > Bolt Load”

9.
 

В окне настроек введите величину 
силы в позиции “Components” 
“X = 100 N”. 

7

6 8

9
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. . . Закрепление
10.Выделите

 
опорную поверхность корпуса (part 1).

11.Задайте закрепление без трения 
(frictionless support):
–

 
“RMB > Insert > Frictionless Support”.

11

10
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. . . Закрепление
•

 
Задайте

 
закрепление без трения 

для конических поверхностей 8 
монтажных отверстий.

•
 

Выберите указанные 
поверхности индивидуально, 
удерживая клавишу CTRL, 
или одновременно 
с использованием функции 
выбора по размеру. 
Во втором случае выберите 
первую поверхность 
и запустите макрос для 
поиска всех поверхностей 
такого же размера. Этот макрос 
работает также с ребрами и 
твердыми телами.
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. . . Закрепление
12.Выделите

 
одну коническую 

поверхность.

•
 

Запустите макрос описка о размеру: 

13.Выберите
 

“Tools > Run Macro . . . “

14.Выберите в папке
 

“selectBySize.js”.
–

 
Внизу указан полный путь к папке 
макросов. 

15. Нажмите “Open”.

13

14

15

12

C:\Program Files\ANSYS Inc\v81\AISOL\DesignSpace\Language\en-us\Pages\macros
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. . . Закрепление
•

 
Ко

 
всем выбранным поверхностям примените 

закрепление без трения (frictionless support):

16.“Контекстное меню
 

> Insert > Frictionless Support”

16
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Макросы

•
 

Результатом
 

действия выше описанного макроса 
является автоматический выбор всех поверхностей 
одинакового размера.

•
 

Макрос эффективно работает в больших сборках, где 
выбор большого числа одинаковых поверхностей может 
занять много времени.

•
 

При использовании макроса убедитесь, что не были 
выбраны «лишние» объекты.

•
 

В папке макросов содержатся и другие макросы. 
Макросы написаны на Jscript, их можно открыть и 
просмотреть в любом текстовом редакторе.
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Решение
•

 
Включите

 
в дерево проекта расчетные результаты:

17.Выделите раздел solution
 

и добавьте эквивалентные 
напряжения:
–

 
“Контекстное меню

 
> Insert > Stress > Equivalent (von-Mises)”

18.Добавьте полную деформацию (Total Deformation).

17

18
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. . . Решение
•

 
Поскольку

 
задано закрепление без трения, а это 

несвязанный контакт, DS инициирует использование 
слабых пружин при решении. Если модель надежно 
закреплена, эту функцию можно отключить. Отключая 
слабые пружины, убедитесь, что

 
движение конструкции 

исключено. В противном случае решение не будет 
сходиться.

19.Выделите раздел Solution и в окне настроек отключите 
слабые пружины: “Weak Springs” >

 
“Off”.

19

20 Решить - Solve

20
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Постпроцессинг
•

 
По

 
окончании расчетов можно выбрать расчетные 

параметры в дереве проекта для просмотра.
–

 
Можно просмотреть распределение расчетного параметра 
в целом по сборке, но уровень напряжений в отдельных 
деталях различается.

•
 

Можно просмотреть распределение расчетного 
параметра в отдельной детали. 
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. . . Постпроцессинг
21.Выделите

 
раздел “Solution” в дереве 

проекта и выберите пиктограмму 
“Body”

 
в графических инструментах .

22.Выберите крыльчатку (part 2).

23.Добавьте в дерево проекта 
эквивалентные напряжения:
–

 
“Контекстное меню

 
> 

Insert > Stress > 
equivalent (von Mises)”

•
 

В окне настроек указано, что 
расчетный параметр задан для 
одного твердого тела -

 
1 Body.

21

22
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. . . Постпроцессинг

•
 

Добавьте
 

полную деформацию -
 

“Total Deformation” для 
крыльчатки.

•
 

Добавьте напряжения и деформацию для корпуса (part 1).

•
 

Измените название расчетных параметров в дереве 
проекта для удобства.

•
 

Снова запустите решение -
 

Solve.  
–

 
Замечание: добавление нового параметра в дерево проекта 
не требует нового решения. Параметр восстанавливается из 
базы данных в другой шкале значений.
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. . . Постпроцессинг
•

 
Анализ

 
крыльчатки показывает, что максимальные 

смещения в детали 0.026 мм, что меньше заданного 
предела 0.075

 
мм).
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. . . Постпроцессинг

•
 

Анализ
 

напряжений в корпусе показывает, что уровень 
напряжений ниже предела текучести 25 МПа.  
Максимальные напряжения обнаружены в области 
монтажных отверстий, которые не представляют интереса 
в данной задаче. Можно ограничить область вывода 
расчетного параметра проблемной зоной.

Максимальные
 напряжения

Проблемная
 

зона
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. . . Постпроцессинг
•

 
Чтобы

 
облегчить выделение проблемной поверхности, 

скройте от просмотра шкив и крыльчатку.

23.Выберите шкив и скройте его: “Контекстное меню
 

> Hide 
Body” (замечание: скрыв от просмотра твердое тело, 
можно просмотреть поверхности и ребра с помощью 
графических инструментов выбора).

•
 

Скройте от просмотра 
крыльчатку.

23
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. . . Постпроцессинг
24.Выделите

 
раздел “Solution” в дереве 

проекта и нажмите пиктограмму “Face” в 
графических инструментах выбора.

25.Выберите 5 поверхностей проблемной 
зоны для корпуса (part 2).

24

25



2009
http://cae.ustu.ru

© О. М. Огородникова

КО
М
П
Ь
Ю
ТЕРН

Ы
Й
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
КО

М
П
Ь
Ю
ТЕРН

Ы
Й

КО
М
П
Ь
Ю
ТЕРН

Ы
Й

КО
М
П
Ь
Ю
ТЕРН

Ы
Й
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
И
Н
Ж
ЕН

ЕРН
Ы
Й

 А
Н
А
ЛИ

З
CAEngineering

85

. . . Постпроцессинг
•

 
Добавьте

 
эквивалентные 

напряжения в список расчетных 
параметров:

–

 

“Контекстное меню
 

> Insert > Stress 
> equivalent (von Mises)”

•
 

В окне настроек указано, что новый 
параметр выводится 
для 5 выбранных поверхностей.

•
 

Выберите еще одну 
поверхность и повторите 
предыдущие действия. 
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. . . Постпроцессинг
•

 
Просмотрите

 
расчетные результаты.

•
 

Закончите работу созданием рисунков и отчета. 



Дополнительные
 

сведения
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… Конечные элементы
•

 
Для

 
создания сетки могут быть использованы следующие 

элементы. 
–

 
Для твердых тел (Solid bodies)

 
используются 10-узловые 

тетраэдры или 20-узловые гексаэдры:
•

 

SOLID187 и
 

SOLID186
–

 
Для поверхностных тел (Surface bodies)

 
используются 4-

 узловые оболочковые элементы:
•

 

SHELL181, толщина оболочки задается действительной 
константой (real constants);

•

 

Сечение оболочки не задается. 
–

 
Для линейных тел (Line bodies) используются 2-узловые 
балочные элементы:

•

 

BEAM188, направление задается третьим узлом;
•

 

учитывается сечение. 
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… Точечная масса
•

 
В

 
ANSYS

 
точечная масса определяется как сосредоточенная масса, 

связанная с поверхностью через ограничения типа RBE3.
–

 

Транслируется из DS в ANSYS
 

с заданной массой только элемент MASS21
 

с 
опциями

 

(KEYOPT(3)=2).
–

 

Ограничения типа RBE3
 

для поверхности 
поддерживаются контактными элементами CONTA174, 
которые генерируются на данной поверхности:

•

 

KEYOPT(2)=2 для алгоритма
 

MPC;
•

 

KEYOPT(4)=1 для определения узла в контакте;
•

 

KEYOPT(12)=5 для связанного контакта.
–

 

Вспомогательный узел TARGE170 генерируется в 
том же узле, где находится точечная масса MASS21.

•

 

KEYOPT(2)=1 для заданных пользователем ограничений; 
•

 

KEYOPT(4)=111111 для всех активных ограничений DOF.
–

 

Тип RBE3 предполагает ограничение 6 степеней свободы DOF, для точечной 
массы MASS21

 

возможно ограничение 3 степеней свободы DOF и не 
определяется инерция вращения. Поскольку используется тип RBE3, а не 
CERIG, для ограничения степеней свободы поверхности, отсутствуют 
явления жесткости между точечной массой и поверхностью. 
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… Сборка –
 

контакт твердых тел
•

 
Контакт

 
твердых тел в ANSYS моделируется с помощью 

элементов
 

CONTA174 и
 

TARGE170.

–

 

По умолчанию используется метод штрафов с относительной 
контактной жесткостью, равной 10, и задается симметричный контакт. 

–

 

Для контактов связанного и без разделения игнорируются зазоры и 
взаимные проникновения контактных поверхностях, если их величина

 не превышает область захвата.
–

 

Для контактов жесткого и без трения допускаются начальные зазоры
 

и 
плавные перекрытия, которые учитываются в расчете до момента 
касания. Касание задается параметром CNOF.

–

 

Параметр NEQIT задается равным 1 для контактов связанного и без 
разделения, и может быть больше (20-40) в зависимости от модели.

Contact Type KEYOPT(2) KEYOPT(5) KEYOPT(9) KEYOPT(12)
Bonded 1 0 1 5
No Separation 1 0 1 4
Frictionless, Actual Geometry 1 0 2 0
Frictionless, Adjusted to Touch 1 1 1 0
Rough, Actual Geometry 1 0 2 1
Rough, Adjusted to Touch 1 1 1 1
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… Сборка –
 

контакт оболочек
•

 
Контакт

 
ребер (для поверхностных или твердых тел) в ANSYS 

задается как асимметричный с помощью элементов 
CONTA175 и

 
TARGE170.

–
 

Для контакта твердых тел по ребрам используется метод штрафов. 
–

 
Для контакта поверхностных тел по ребрам используется метод 
MPC. Направление поиска контакта задается не нормалью к 
целевой поверхности, а областью захвата, что указывается в 
определении элемента TARGE170

 
опцией KEYOPT(5)=4.

–
 

По умолчанию для связанного контакта 
задаются опции KEYOPT(12)=5 
и

 
KEYOPT(9)=1.

•
 

Если контактируют собственно 
поверхности, задается обычный 
контакт поверхность-поверхность 
с помощью элементов 
CONTA174 
и

 
TARGE170 Пример

 

контакта ребро-

 
ребро с элементами 
CONTA175 на одном ребре 
и TARGE170 –

 

на другом.
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… Сборка –
 

точечная сварка
•

 
Точечная

 
сварка задается элементами BEAM188. Один 

балочный элемент связывает элементы двух деталей 
(оболочковых или твердотельных), образуется «паутина» 
связей.
–

 
Для элементы

 
BEAM188 

задаются те же свойства 
материалов, что и для 
деталей, и круглое сечение

 с радиусом в 5 раз больше 
толщины оболочек.  

–
 

В примере показаны
 элементы точечной сварки

 между двумя оболочками.
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Инерционные
 

нагрузки в
 

ANSYS
•

 
Инерционные

 
нагрузки в ANSYS задаются следующими 

командами.
–

 
Ускорение (Acceleration) и гравитация

 
(Standard Earth Gravity) 

задаются командой ACEL.
–

 
Скорость вращения (Rotational velocity) задается командами 
CGLOC (начало координат) and CGOMGA (скорость вращения 
относительно заданной точки CGLOC)
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Конструкционные
 

нагрузки в ANSYS
•

 
Конструкционные

 
нагрузки в ANSYS задаются следующим 

образом. 
–

 
Давление (Pressures) прикладывается к поверхности и задается 
командой SF,,PRES

–
 

Сила (Forces), приложенная к вершине или ребру, является 
узловой нагрузкой и задается командой F,,FX/FY/FZ

–
 

Распределенная по поверхности сила (Forces) прикладывается 
как давление к элементам SURF154

 
с опцией KEYOPT(11)=2

•

 

Опция KEYOPT(11)=2 учитывает касательную компоненту силы. 
–

 
Давление опоры (Bearing loads) прикладывается как давление к 
элементам SURF154.  Учитываются аксиальная и радиальная 
составляющие. 

•

 

Аксиальная компонента (Axial) учитывается опцией KEYOPT(11)=2
 для всей поверхности.

•

 

Радиальная компонента (Radial) учитывается опцией KEYOPT(11)=0 
для цилиндрической поверхности, испытывающей сжатие. 

–
 

Момент (Moments) задается в вершине или на ребре оболочки 
как узловая нагрузка командой F,,MX/MY/MZ
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… Конструкционные нагрузки в ANSYS

•
 

Момент, приложенный к поверхности, (Moment) определяется 
граничными условиями. 

–

 

Закрепление поверхности типа RBE3
 

для распределенных нагрузок. 
–

 

Вспомогательный узел на поверхности задается контактным элементом 
TARGE170 с опциями

 

KEYOPT(2)=1 и
 

KEYOPT(4)=xxx000
–

 

Поверхность задается контактными элементами CONTA174 
с опциями

 

KEYOPT(2)=2, KEYOPT(4)=1, KEYOPT(12)=5
–

 

Момент прикладывается как узловая нагрузка 
во вспомогательной точке. 

•
 

Удаленная сила (Remote force) задается граничными условиями. 
–

 

Закрепление поверхности типа RBE3
 

для распределенных 
нагрузок.

–

 

Вспомогательный узел на поверхности задается 
контактным элементом TARGE170 с опциями

 KEYOPT(2)=1 и
 

KEYOPT(4)=xxx000
–

 

Поверхность задается контактными элементами CONTA174 
с опциями

 

KEYOPT(2)=2, KEYOPT(4)=1, KEYOPT(12)=5
–

 

Сила прикладывается как узловая нагрузка 
во вспомогательной точке.
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Закрепление
 

конструкции в
 

ANSYS
•

 
Закрепление

 
в

 
ANSYS

 
задается следующим образом.

–

 

Ограничение всех степеней свободы (Fixed Support) задается командой 
D,,ALL для выбранного геометрического объекта.

–

 

Заданное перемещение (Given displacement) вводится командой
 D,,UX/UY/UZ для указанного направления (поворот осуществляется в 

выбранной системе координат).
–

 

Закрепление поверхности без трения (Frictionless)
 

разрешает поворот, 
но ограничивает перемещение по нормали D,,UX, нормаль совпадает с 
осью UX.

–

 

Цилиндрическое закрепление (Cylindrical constraint)
 

разрешает поворот 
в цилиндрической системе координат и запрещает перемещение 
командой D,,UX/UY/UZ.

–

 

Запрет перемещений оболочек и балок (Simply supported constraints) 
задается командой

 

D в направлениях
 

UX, UY, UZ.
–

 

Запрет поворотов оболочек и балок (Fixed rotation constraints) задается 
командой

 

D относительно осей
 

ROTX, ROTY, ROTZ.
–

 

Закрепление сжимаемой поверхности (compression-only supports) 
сопровождается копированием поверхностной сетки для создания 
жесткой целевой поверхности (TARGE170) поверх исходной поверхности 
(CONTA174).  Далее применяется обычное моделирование контакта, 
решение является нелинейным.
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Обзор
 

закреплений
•

 
Закрепления

 
и контактные области формируют граничные 

условия.
–

 
Контактные области позволяют задавать податливые 
граничные условия между деталями, присутствующими  в 
расчетной модели явно.  

–
 

Закрепления позволяют задавать жесткие граничные  условия 
между деталью и другой –

 
жесткой, неподвижной деталью, не 

присутствующей в расчетной модели явно. 

•
 

Чтобы учесть взаимное влияние двух контактирующих деталей, 
можно обе детали включить в модель и задать контактные условия, 
или включить в модель одну деталь, а влияние другой учесть как 
закрепление.
–

 
Замена детали закреплением применяется, когда исключаемая 
деталь ведет себя жестко.

Тип закрепления Эквивалентные контактные условия на поверхности детали
Fixed Support Bonded contact  with a rigid, immovable part
Frictionless Support No Separation contact  with a rigid, immovable part
Compression Only Support Frictionless contact with a rigid, immovable part
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Тепловые
 

нагрузки
 

в
 

ANSYS
•

 
Решение

 
тепловых зада в ANSYS. 

–
 

В ANSYS сначала решается тепловая задача. 
•

 

Тепловой анализ выполняется даже в том случае, если задано 
однородное температурное поле. В модуле ANSYS Structural

 тепловая задача не решается. 
–

 
Исходная температура (Reference temperature) задается 
командой TREF (не в свойствах материала -

 
MP,REFT).

•

 

Команды TREF и
 

TUNIF задают одно и то же значение справочной 
температуры, которое указано в позиции “Reference Temp” в окне 
настроек раздела Environment.

–
 

ТКЛР является свойством материала и задается командой 
MP,ALPX (не опциями

 
MP,CTEX или

 
MP,THSX).
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Опции
 

решателя
 

в ANSYS
•

 
Выбор

 
прямого или итерационного решателя. 

–

 

Выбор решателя прямого разреженного -
 

direct sparse solver 
(EQSLV,SPARSE) или итерационного -

 

PCG solver (EQSLV,PCG)
 

задается 
опцией в команде.

–

 

Различие решателей. 
•

 

В линейном статическом анализе решается уравнение [K]{x} = {F}, Прямой 
решатель -

 

Direct solver

 

–

 

проводит факторизацию матрицы жесткости [K] и 
вычисляет матрицу

 

[K]-1. Тогда искомая матрица

 

{x} = [K]-1{F}. 
–

 

Такая факторизация требует большого объема вычислений и производится 
за один проход.

•

 

Итерационный решатель -

 

Iterative solver

 

вычисляет предусловную

 

матрицу [Q] и 
решает уравнение

 

[Q][K]{x} = [Q]{F}. Если

 

[Q] = [K]-1,

 

то

 

[I]{x} = [K]-1{F}. В общем 
случае предусловная

 

матрица не равна [K]-1. Но чем ближе

 

[Q] к

 

[K]-1, тем точнее 
проводится предварительная обработка данных. Процесс обработки данных 
повторяется итерационно.

–

 

Итерационный решатель производит умножение матриц, а не факторизацию. 
Умножение при использовании только оперативной памяти производится 
быстрее, чем инверсия. Поэтому если количество итераций невелико, что 
справедливо для хорошо обусловленных матриц, итерационный решатель 
работает более эффективно, чем прямой разреженный.

–

 

Основное различие итерационных решателей, используемых в ANSYS —

 
PCG, JCG, ICCG —

 

заключается в определении предусловной

 

матрицы.
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Опции
 

решателя
 

в ANSYS
•

 
Опция

 
слабой пружины -

 
Weak spring.

–
 

При необходимости слабые пружины добавляются в сетку. 
Слабые пружины моделируются с помощью элемента 
COMBIN14 с малой заданной жесткостью и добавляются в 
случае предельных размеров детали.

•
 

Рабочая папка решателя.
–

 
Входные файлы ANSYS записываются в файл “ds.dat” в 
папке решателя. Выходные данные записываются в файл 
“solve.out” и могут быть просмотрены в позиции “Solution 
Information” раздела

 
“Solution”.

–
 

ANSYS может проводить вычисления в batch моде (-b) 
автономно.  Расчетные результаты записываются в файл .rst.  
В batch моде генерируются файлы результатов XML.  Файлы

 XML затем читаются в программе.
–

 
Все файлы проекта

 
ANSYS по умолчанию имеют одно 

название “file” и удаляются по окончании расчетов. 
Сохранить файлы можно, обратившись в меню “Tools > 
Options … > Simulation: Solution > Save Ansys Files”.
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•

 
Некоторые

 
функции ANSYS выключаются командами при 

вычислениях: 
–

 
Solution control

 
–

 
контроль вычислений

 
(SOLCON,OFF)

–
 

Multiframe
 

restart
 

–
 

возобновление сверхциклов 
(RESCON,,NONE)

–
 

ANSYS shape checking –
 

контроль формы элементов
 (SHPP,OFF)

–
 

Number of equilibrium iterations (NEQIT) –
 

число равновесных 
итераций устанавливается равным 1, если контакты не 
заданы или все контакты связанные (или без разделения).

•

 

Автоматически назначается NEQIT,20 для контактов без трения 
(frictionless contact) или

 

NEQIT,40 для жесткого контакта (rough 
contact).  В этом случае задаются также подшаги

 

NSUBST,1,10,1
–

 
Только выбранные расчетные параметры записываются в 
выходной файл OUTRES.

•

 

Затем расчетные результаты записываются в файл XML
 

в 
постпроцессоре /POST1, который читается программой. 
Программа не читает результаты напрямую из файла.rst
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